The DeltaV Export Configuration Tool is an OpenEnterprise component that enables you to configure and export a control strategy file that can be imported to a DeltaV Virtual Controller. That makes OpenEnterprise SCADA data available to the DeltaV community.

In this context, an RTU is a Remote Terminal Unit that is also a process controller (typically a ControlWave™ or ROC™ device). The configuration tool enables you to:

- View and select the remote signals that you want to export to DeltaV
- Create a corresponding control strategy module file (.FHX) for a DeltaV Virtual Controller
- Configure the OPC Mirror to pass the selected signal data from OpenEnterprise to the Virtual Controller
1.1 DeltaV RTU Connect

DeltaV RTU Connect is an integrated software suite, centering around the OpenEnterprise SCADA application, that enables data from remote RTUs to be passed into a DeltaV plant. It is installed onto a DeltaV Application Station.

2. How-to Guide

This is a high level list of tasks required to configure the Export Configuration Tool. Some tasks link to topics which break the tasks down into smaller units.

1. How to Open the Export Configuration Tool
2. How to Create alarm associations
3. How to Search for signals from the RTU Connect
4. How to Create and Export the DeltaV control strategy
5. How to Configure the PI Server

Note: For instructions on how to configure a DeltaV RTU Connect application station, please see document number D301690x412 entitled “DeltaV RTU Connect - Getting Started”. This will be available on the installation media or from the Emerson public web site.

2.1 How to Open the Configuration Tool

2.1.1 From the Start Button

This opens the Export Configuration Tool with default settings applied from the OpenEnterprise settings file.

1. Select Start > All Programs > OpenEnterprise > Toolbox.
2. Double click on the Gateway Export tool within the Toolbox.

2.1.2 Command Line Parameters

The command line parameters can be used to vary how the Export Configuration Tool opens. They may be applied directly from the command line or as command line parameters to the task in the Session Manager.

- \( -s: \) Database service
- \( -u: \) Username
- \( -p: \) Password
- \( -n: \) Devicename - inserts the devicename into the devicename text box on startup

2.2 How to Create Alarm Associations

1. Select Tools > Properties from the menu bar.
2. Select the Alarm Association page from the left pane of the Properties dialog.
3. Create your alarm associations - for more information see the Alarm Association topic.

2.3 How to Search for Signals

1. Using the DeltaV Export Configuration Tool interface, create your search criteria, then view the signals.
   - See the Search Criteria Controls topic for more information on creating search criteria.
   - See the Search List Pane topic for information on the search list itself.
2. Define other rule sets if required See the Working with rule sets topic for more information.
3. Use aliases in rule sets to fine tune your searches. See the How to use Aliases in Searches topic for instructions.
2.3.1 How to Work with Rule Sets

1. See the Rule Sets Pane topic for more information on working with rule sets.
2. See the Tool Bar topic for more information on exporting and importing rule sets.

2.3.2 How to use Aliases in Searches

It is possible to create rules that contain aliases in order to refine searches for tags. Aliases can be defined within the Device name, Instance, Base, Extension, and Attribute fields. This is an example of one way aliases can be created and used.

1. Create the first rule set using an alias and one other real value in the search criteria controls.
   a. Type the alias by enclosing it in double pipe characters - e.g., ||BASE||.
   b. Add an actual value in at least one other field.
   c. Click the button highlighted in red to add the defined search to the configured rule sets.

2. Change the real value to another valid value and create a second rule set.
   a. Leave the ||BASE|| alias there.
   b. Change the Attribute alias.
   c. Add the new search to the rule sets.

3. Create a third rule set.
   a. Leave the ||BASE|| alias there.
   b. Change the Attribute alias again.
   c. Add the final search to the rule sets.
4. Finally, give the alias a value in the search criteria and use the rule sets to find the tags of interest.

2.4 How to Create the DeltaV Control Strategy

Having got to this stage, you should already have searched for and created a list of signals that you are interested in exporting to DeltaV. See the How to Search for Signals section for instructions.

1. Before you begin, decide if you want to modify the default names for control strategy areas and modules. See the How to Modify Default Control Strategy Areas and Module Names topic for more information.
2. Also before you begin, consider how you will convert your OpenEnterprise tag names so that the DeltaV 16 character limit is not broken. See the Tag Format Page for further information.
3. Add Area and Module nodes to your control strategy using the DeltaV Pane. See the DeltaV Pane topic for more information.
4. Select the required signals and drag them from the Search List pane to the DeltaV pane. For more information see the Search List Pane topic.
5. Check the status pane to see if there are any signal names that need to be changed. See the Status Pane topic for more information.
6. Modify or shorten signal names. See the How to Modify Signal Names topic for more information.

7. If there is no further warning about tagnames in the Status Pane, click the [Export] button at the top of the DeltaV pane. See the DeltaV Pane topic for more information on the [Export] button. This will export the .FHX file using the file name and location configured on the General Properties Page.

8. From the DeltaV ProPlus workstation download this control strategy file to the virtual controller on the DeltaV RTU Connect machine.

2.4.1 How to Modify Default Control Strategy Areas and Module Names

2. Select the Tag Format page. The Area / Module name format section at the bottom of this page contains input fields to change these default names. See the Tag Format topic for more information.

2.4.2 How to Modify Signal Names

1. If you have many signals to change and you can live with a shortened format being applied to all tagnames:
   a. Select Tools > Properties from the Export Configuration Tool menu bar.
   b. Use the tag format page of the properties dialog to make the necessary changes.
   c. When you have finished making the changes, click the [OK] button at the bottom of the Tag Format page, and you have the choice of applying the name changes immediately. See the Tag Format topic for more information.

2. If you only have a small number of tag names to change:
   a. Use the left and right buttons in the DeltaV explorer view. These will be highlighted if any tag names require a name change.
   b. On pressing the right button the next signal requiring a name change will be highlighted for modification.
   c. The left and right arrow keys can also be used instead of the buttons. This particular method is useful if you want to modify only the tagnames that require changing (rather than forcing tagname changes to be applied to all signals). See the DeltaV Pane topic for more information.

2.5 How to Configure the PI Server

1. Open the property pages by selecting Tools | Properties from the Export Configuration Tool menu bar.
2. Select the Historical Backfill pages.
3. On the General Historical Backfill page you can change the way the RTU Connect handles historical streaming to the PI database. See the Historical Backfill General Page topic for more details.
4. On the PI Server page you can specify the name of the PI Server (unless you’re using the default PI server). You can also configure how the RTU Connect should handle new PI points when streaming the data and modify PI Server logon credentials if necessary. See the Historical Backfill PI Server Page topic for more details.
3. Knowledge Base

The aim of this section is to help you to understand how the DeltaV RTU Connect integrates remote RTU data collected by OpenEnterprise into DeltaV systems.

A diagrammatic representation of DeltaV RTU Connect integration is shown below. The headings below it will explain each element of the diagram.

3.1 DeltaV Plant

The RTU Connect enables RTU data to be integrated into a DeltaV system using the following DeltaV components:

- An application station running OpenEnterprise which is collecting data from RTUs.
- A DeltaV virtual controller which makes the data from the RTUs available to the DeltaV system.
- A second application station running the PI historical database and the Plantwide Event Historian to provide historical signal and alarm-event data from the RTUs.
3.2 ProPlus Workstation

The ProfessionPLUS (or ProPlus) workstation is used to provide a single administrative point of entry, allowing for access to all aspects of a DeltaV integrated solution (including third party applications).

The ProPlus workstation also contains the central DeltaV configuration database. A ProPlus workstation is a requirement of every DeltaV network. There can be only one ProPlus workstation per system.

3.3 Operator Workstation

A DeltaV operator workstation provides standard plant operational capability. This includes the use of control displays, real-time and historical trending capabilities and the ability to view and process alarms.

3.4 Application Station

As part of the DeltaV suite a user can configure a desktop or server to host a DeltaV application station. The application station is used to integrate DeltaV and other applications into the enterprise. A single system can host up to 20 application stations, each with their own virtual controller.

The DeltaV RTU Connect is installed onto a DeltaV application station. Typically, the OpenEnterprise part of the RTU Connect will be installed on one application station and the Plantwide Event Historian and PI Historian are installed on a separate application station.

3.5 DeltaV Controller

A plug and play controller that executes control logic based on the process signals derived from the I / O subsystem and provides communication to the rest of the DeltaV control system for operator interaction and data collection.

The controller’s primary function is to execute control modules that are designed to meet the specific control requirements of the plant. These control modules use process signals from the controller’s I / O subsystem and provide communication of process data to the rest of the DeltaV control system for operator interaction and data collection.

3.6 Virtual Controller

This is an IEC 61-1131 emulated DeltaV controller (in effect a soft programmable logic controller). The DeltaV Export Configuration Tool creates a control strategy file (an .FHX file) that contains references to the remote RTU signals. The control strategy is then downloaded to the virtual controller from the DeltaV system.

The control strategy contains input signal tags which can be arranged by the Export Configuration Tool within alarm function blocks, linking process signals with their alarm limits.
The virtual controller inputs are connected to the OpenEnterprise OPC Data Access server via the OPC Mirror in order to receive real-time data from the DeltaV RTU Connect.

In this way the virtual controller pushes data from the RTU Connect into the DeltaV network to emulate passed through real-time data and alarms from remote controllers.

3.7 Remote Controllers
These are remote ControlWave or ROC controllers that are being integrated into the DeltaV system through the DeltaV RTU Connect.

3.8 Plantwide Event Historian
The Plantwide Event Historian (PEH) captures, stores and displays event data for an entire plant. It records plant event information from any OPC alarm and event server, including the OpenEnterprise OPC Alarm and Event server, and stores that information in a Microsoft SQL Server database.

For more details on how the RTU Connect integrates alarm and event data into DeltaV see the Alarm and Event Integration topic.

3.9 PI Historian
The PI Historian is a standard enterprise database developed by OSIsoft™ that allows for an embedded, centralized alternative to the native DeltaV continuous historian. The PI Historian can be installed onto an application station and embedded into a DeltaV system.

The DeltaV RTU Connect streams historical backfill data via the PI client to the PI historian. DeltaV operator workstations are configured to request historical data from the PI Historian rather than the DeltaV continuous historian.

For more details on how the RTU Connect integrates signal history into DeltaV, see the Historical Integration topic.

3.10 OpenEnterprise
OpenEnterprise is an industrial strength SCADA (Supervisory Control and Data Acquisition) system. OpenEnterprise collects data from Remote Telemetry Units (RTUs) using direct low level communications programs and serves the data to clients, normally through standard OPC and ODBC application interfaces.

Typical systems include a processing plant (for instance a well head, pipeline or water processing plant) connected to ControlWave or ROC RTUs and communication systems to transmit the data back to the OpenEnterprise server database.

3.11 OPC Data Access
OPC Data Access is a group of standards that provides specifications for communicating real-time data from automation controllers. Real-time data is streamed from the DeltaV RTU Connect through to DeltaV by means of the OPC Mirror application.

For more information on how the DeltaV RTU Connect integrates real time data into DeltaV through OCP Data Access, see the Real Time Integration topic.
3.12 PI Client

The Historical Export Application uses the PI SDK to stream historical data from OpenEnterprise to the PI Historian.

For more information on how the DeltaV RTU Connect integrates historical data into DeltaV through the Historical Export Application, see the Historical Integration topic.

3.13 DeltaV RTU Connect

3.13.1 DeltaV RTU Connect

The DeltaV RTU Connect is a suite of software components that when installed together or separately onto DeltaV Application Station nodes within a DeltaV system make it possible to integrate real-time, alarm-event and historical data from remote ControlWave and ROC devices into that DeltaV system:

1. Real Time Integration
2. Historical Integration
3. Alarm and Event Integration

3.13.2 Real Time Integration

In order to allow for the provision of real-time logged data, the DeltaV RTU Connect uses OPC Data Access connectivity.
3.13.2.1 The DeltaV Export Configuration Tool
The DeltaV Export Configuration Tool allows you to select the remote RTU tags that you want to integrate into the DeltaV system. You can then export these tags to a control strategy module file (.FHX), which DeltaV downloads to a virtual controller module.

The Export Configuration Tool also sends mapping information from your selected signals to the OPC Mirror, which enables the OpenEnterprise OPC server and the DeltaV OPC servers to pass the signal data between themselves. The DeltaV OPC server then pushes the RTU data to the virtual controller and it becomes integrated into the DeltaV system.

The Export Configuration Tool also allows you to configure historical integration via the PI Historian.

3.13.2.2 The OPC Mirror
The OPC Mirror is able to create a channel that streams data between two OPC servers. This channel is called a "pipe". The configuration required for the OPC Mirror to form a pipe is:

1. The program id of the OpenEnterprise OPC server (let’s call this A)
2. The program id of the DeltaV OPC server (let’s call this B)
3. The direction of the piping
   a. From A to B
   b. From B to A
   c. Both ways (this is the option used)
4. A map of the required signal data.

This is all done automatically when you export an .FHX file using the DeltaV Export Configuration Tool. The Export Configuration Tool configures the OPC Mirror at the same time that it exports the .FHX file.

The only thing you will need to do regarding the OPC Mirror itself is to provide a DeltaV administrator name and password when you install it onto the DeltaV RTU Connect application station. The Export Configuration Tool will do the rest.

3.13.2.2 The OpenEnterprise OPC Server
The OpenEnterprise OPC Data Access server makes data from the OpenEnterprise database available to OPC clients. Its program id is **BristolBabcock.BristolOPCServer**.

3.13.2.4 The DeltaV OPC Server
The DeltaV OPC server makes data from the RTU Connect available to the DeltaV virtual controller on the application station, which in turn makes it available to the rest of the DeltaV system. Its program id is **OPC.DeltaV.1**.

3.13.2.5 Virtual Controller
This is an IEC 61-1131 emulated DeltaV controller (in effect a soft programmable logic controller). The DeltaV Export Configuration Tool creates a control strategy file (an .FHX file) that contains references to the remote RTU signals. The control strategy is then downloaded to the virtual controller from the DeltaV system.
The control strategy contains input signal tags which can be arranged by the Export Configuration Tool within alarm function blocks, linking process signals with their alarm limits.

The virtual controller inputs are connected to the OpenEnterprise OPC Data Access server via the OPC Mirror in order to receive real-time data from the DeltaV RTU Connect.

In this way the virtual controller pushes data from the RTU Connect into the DeltaV network to emulate passed through real-time data and alarms from remote controllers.

### 3.13.2.6 OpenEnterprise

OpenEnterprise is an industrial strength SCADA (Supervisory Control and Data Acquisition) system. OpenEnterprise collects data from Remote Telemetry Units (RTUs) using direct low level communications programs and serves the data to clients, normally through standard OPC and ODBC application interfaces.

Typical systems include a processing plant (for instance a well head, pipeline or water processing plant) connected to ControlWave or ROC RTUs and communication systems to transmit the data back to the OpenEnterprise server database.

### 3.13.2.7 Remote Device Interfaces (RDIs)

OpenEnterprise communicates with ControlWave and ROC RTUs using a set of device drivers called Remote Device Interfaces (RDIs). Collected data can consist of current values, history and alarm and event data.

#### 3.13.2.7.1 The ControlWave RDI

The ControlWave RDI is also known as the NW3000 RDI since the original family of Bristol™ devices were known by the name Network 3000.

The ControlWave RDI (Remote Device Interface) is installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ControlWave RTUs.
The ControWave RDI’s configuration program is the NW3000 Setup Tool, which utilizes two other programs:

- The NW3000 Signal Builder inserts, modifies and deletes signals from the database
- The Template Builder creates polling templates from those signals for efficient data collection.

The ControlWave RDI requires OpenBSI to be installed on the same machine along with the ControlWave control strategy files and network definition.

3.13.2.7.2 The ROC RDI
The ROC RDI (Remote Device Interface) is also installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ROC and FloBoss™ RTUs.

ROC RDI is has its own configuration tool which enables you to add ROC devices and points to the database and schedule data collection.

3.13.2.8 Polling of RTUs
The frequency of real-time updates through the OPC Mirror will be restricted by the rate at which OpenEnterprise is able to collect the data. In many cases where only a dial-up connection exists, this may be once a day, and/or on demand. At that time, the RTU Gateway will obtain historical signal data from the RTUs and stream it to DeltaV.

3.13.3 Historical Integration
There are two methods available for getting historical data from the RTU Connect. It is intended and recommended that most systems use both methods, so that no data is lost:

1. Data pass through. Data is passed directly from the Gateway’s virtual controller via the PI OPC server to the PI database.
2. Use the Gateway Historical Export application to export historical data directly to the PI database.

Method 1 above is good where OpenEnterprise can poll the remote controllers at relatively short intervals.

Method 2 provides a historical backfill service to the PI historical database if the connection to the remote controllers is lost. If OpenEnterprise cannot poll the remote controllers at short intervals, this will be the main method of integrating historical data.
3.13.3.1 Historical Data Pass Through
Real time signal updates are collected from the Gateway’s virtual controller by the PI OPC server and inserted as historical samples directly into the PI database.

3.13.3.1.1 OpenEnterprise
OpenEnterprise is an industrial strength SCADA (Supervisory Control and Data Acquisition) system.

OpenEnterprise collects data from Remote Telemetry Units (RTUs) using direct low level communications programs and serves the data to clients, normally through standard OPC and ODBC application interfaces.

Typical systems include a processing plant (for instance a well head, pipeline or water processing plant) connected to ControlWave or ROC RTUs and communication systems to transmit the data back to the OpenEnterprise server database.

3.13.3.1.2 The OpenEnterprise OPC Server
The OpenEnterprise OPC Data Access server makes data from the OpenEnterprise database available to OPC clients. Its program id is **BristolBabcock.BristolOPCServer**.
3.13.3.1.3 OPC Mirror

The OPC Mirror is able to create a channel that streams data between two OPC servers. This channel is called a “pipe”. The configuration required for the OPC Mirror to form a pipe is:

1. The program id of the Bristol OPC server (let’s call this A)
2. The program id of the DeltaV OPC server (let’s call this B)
3. The direction of the piping
   a. From A to B
   b. From B to A
   c. Both ways (this is the option used)
4. A map of the required signal data.

This is all done automatically when you export an .FHX file using the DeltaV Export Configuration Tool. The Export Configuration Tool configures the OPC Mirror at the same time that it exports the .FHX file.

The only thing you will need to do regarding the OPC Mirror itself is to provide a DeltaV administrator name and password when you install it onto the DeltaV RTU Connect application station. The Export Configuration Tool will do the rest.

3.13.3.1.4 DeltaV OPC Server

The DeltaV OPC server makes data from the RTU Connect available to the DeltaV virtual controller on the application station, which in turn makes it available to the rest of the DeltaV system. Its program id is **OPC.DeltaV.1**.

3.13.3.1.5 Virtual Controller

This is an IEC 61-1131 emulated DeltaV controller (in effect a soft programmable logic controller). The DeltaV Export Configuration Tool creates a control strategy file (an .FHX file) that contains references to the remote RTU signals. The control strategy is then downloaded to the virtual controller from the DeltaV system.

The control strategy contains input signal tags which can be arranged by the Export Configuration Tool within alarm function blocks, linking process signals with their alarm limits.
The virtual controller inputs are connected to the OpenEnterprise OPC Data Access server via the OPC Mirror in order to receive real-time data from the DeltaV RTU Connect. In this way the virtual controller pushes data from the RTU Connect into the DeltaV network to emulate passed through real-time data and alarms from remote controllers.

3.13.3.1.6 PI OPC Interface
The DeltaV OPC server makes data from the RTU Connect available to the DeltaV virtual controller on the application station, which in turn makes it available to the rest of the DeltaV system. Its program id is 

3.13.3.1.7 EntHist Configuration File
The PI database uses 'PI points' to store tag information in the pipoint table, each point mapping across to a single DeltaV tag.

In order to configure these automatically, the PI historian sources tag information from the EntHist configuration file, created in the DeltaV file system.

This is a standard XML file containing details of which tags have been configured for historical data logging.

The EntHist file can only be created when the following has been done:

1. The PI historian must be enabled within DeltaV to be the historical data source
2. Signals must have been exported from the Export Configuration Tool, and downloaded to the Gateway’s virtual controller.

DeltaV will then create the EntHist configuration file for the PI historian, and the PI OPC Interface will begin passing data through for the tags configured in the EntHist file.

3.13.3.1.8 PI Historian
The PI Historian is a standard enterprise database developed by OSIsoft that allows for an embedded, centralized alternative to the native DeltaV continuous historian. The PI Historian can be installed onto an application station and embedded into a DeltaV system.

The DeltaV RTU Connect streams historical backfill data via the PI client to the PI historian. DeltaV operator workstations are configured to request historical data from the PI Historian rather than the DeltaV continuous historian.

3.13.3.1.9 Remote Device Interfaces (RDIs)
OpenEnterprise communicates with ControlWave and ROC RTUs using a set of device drivers called Remote Device Interfaces (RDIs). Collected data can consist of current values, history and alarm and event data.

3.13.3.1.9.1 The ControlWave RDI
The ControlWave RDI is also known as the NW3000 RDI since the original family of Bristol devices were known by the name Network 3000.

The ControlWave RDI (Remote Device Interface) is installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ControlWave RTUs.
OpenEnterprise DeltaV Export Configuration Tool

The ControWave RDI’s configuration program is the NW3000 Setup Tool, which utilizes two other programs:

- The NW3000 Signal Builder inserts, modifies, and deletes signals from the database.
- The Template Builder creates polling templates from those signals for efficient data collection.

The ControlWave RDI requires OpenBSI to be installed on the same machine along with the ControlWave control strategy files and network definition.

3.13.3.1.9.2 The ROC RDI
The ROC RDI (Remote Device Interface) is also installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ROC and FloBoss RTUs.

ROC RDI is has its own configuration tool which enables you to add ROC devices and points to the database and schedule data collection.

3.13.3.1.10 Polling of RTUs
The frequency of real-time updates through the OPC Mirror will be restricted by the rate at which OpenEnterprise is able to collect the data. In many cases where only a dial-up connection exists, this may be once a day, and / or on demand. At that time, the RTU Gateway will obtain historical signal data from the RTUs and stream it to DeltaV.

3.13.3.1.11 OpenEnterprise Historical Backfill
When OpenEnterprise polls remote RTUs for their data, it can also request historical data that has been stored in the RTUs from the last time the data was polled.

This data is then retrospectively backfilled into the OpenEnterprise history tables, so no historical data is lost between polls.

This is important, because some systems are so remote that a connection can only be made once a day or on a one-shot basis. Even systems with a permanent connection can experience connection breakdown from time to time, but historical backfill guarantees that no data is lost.

In order to utilize the backfill service there are three areas of configuration required across the system:

1. A historical stream must be configured within the device.
   a. For ROC devices, you should use ROCLink™ 800 to configure signals for historical storage within a history segment. For further help consult the ROCLink 800 documentation.
   b. For ControlWave devices, you need to configure an Archive module to store the required signal values historically. For further help consult the ControlWave Designer or ACCOL documentation.
OpenEnterprise DeltaV Export Configuration Tool

2. OpenEnterprise must be configured to collect the historical data.
   a. For ROC devices, this can be achieved using the ROC configuration tool. For further help, consult the ROC Configuration Tool Reference Guide (document number D301654x412).
   b. For ControlWave devices you need to set up NW3000 Archiving. For further help, consult the NW3000 Archiving Overview (document number D301506x412) and NW3000 Archive Configuration (document number D301505x412) Reference Guides.

3. DeltaV must be configured to use the embedded PI Historian. For further help see the DeltaV documentation.

3.13.3.2 Historical Backfill Integration

Historical signal data from the DeltaV RTU Connect is imported to the DeltaV system by means of the Historical Export application.

3.13.3.2.1 The DeltaV Export Configuration Tool

The DeltaV Export Configuration Tool allows you to select the remote RTU tags that you want to integrate into the DeltaV system. You can then export these tags to a control strategy module file (.FHX), which DeltaV downloads to a virtual controller module.

The Export Configuration Tool also sends mapping information from your selected signals to the OPC Mirror, which enables the OpenEnterprise OPC server and the DeltaV OPC servers to pass the signal data between themselves. The DeltaV OPC server then pushes the RTU data to the virtual controller and it becomes integrated into the DeltaV system.

The Export Configuration Tool also allows you to configure historical integration via the PI Historian.
3.13.3.2.2 The Gateway Historical Export Application
This is a server application that runs as part of the OpenEnterprise session. It streams historical data from OpenEnterprise to the embedded PI Historical database that resides on a DeltaV application station.

For more information, see the Gateway Historical Export application topic.

3.13.3.2.3 PI Client
The Historical Export Application uses the PI SDK to create a PI client which streams historical data from OpenEnterprise to the PI historian.

The Emerson RTU Gateway streams historical backfill data via the PI client to the PI historian. DeltaV operator workstations are configured to request historical data from the PI Historian rather than the DeltaV continuous historian.

3.13.3.2.4 OpenEnterprise
OpenEnterprise is an industrial strength SCADA (Supervisory Control and Data Acquisition) system.

OpenEnterprise collects data from Remote Telemetry Units (RTUs) using direct low-level communications programs and serves the data to clients, normally through standard OPC and ODBC application interfaces.

Typical systems include a processing plant (for instance a well head, pipeline or water processing plant) connected to ControlWave or ROC RTUs and communication systems to transmit the data back to the OpenEnterprise server database.

3.13.3.2.5 Remote Device Interfaces (RDIs)
OpenEnterprise communicates with ControlWave and ROC RTUs using a set of device drivers called Remote Device Interfaces (RDIs). Collected data can consist of current values, history and alarm and event data.

3.13.3.2.5.1 The ControlWave RDI
The ControlWave RDI is also known as the NW3000 RDI since the original family of Bristol devices were known by the name Network 3000.

The ControlWave RDI (Remote Device Interface) is installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ControlWave RTUs.

The ControlWave RDI’s configuration program is the NW3000 Setup Tool, which utilizes two other programs:

- The NW3000 Signal Builder inserts, modifies, and deletes signals from the database.
- The Template Builder creates polling templates from those signals for efficient data collection.

The ControlWave RDI requires OpenBSI to be installed on the same machine along with the ControlWave control strategy files and network definition.
3.13.3.2.5.2 The ROC RDI
The ROC RDI (Remote Device Interface) is also installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ROC and FloBoss RTUs.

ROC RDI is has its own configuration tool which enables you to add ROC devices and points to the database and schedule data collection.

3.13.3.2.6 Polling of RTUs
The frequency of real-time updates through the OPC Mirror will be restricted by the rate at which OpenEnterprise is able to collect the data. In many cases where only a dial-up connection exists, this may be once a day, and / or on demand. At that time, the RTU Gateway will obtain historical signal data from the RTUs and stream it to DeltaV.

3.13.3.2.7 OpenEnterprise Historical Backfill
When OpenEnterprise polls remote RTUs for their data, it can also request historical data that has been stored in the RTUs from the last time the data was polled.

This data is then retrospectively backfilled into the OpenEnterprise history tables, so no historical data is lost between polls.

This is important, because some systems are so remote that a connection can only be made once a day or on a one-shot basis. Even systems with a permanent connection can experience connection breakdown from time to time, but historical backfill guarantees that no data is lost.

In order to utilize the backfill service there are three areas of configuration required across the system:

1. A historical stream must be configured within the device.
   a. For ROC devices, you should use ROCLink 800 to configure signals for historical storage within a history segment. For further help consult the ROCLink 800 documentation.
   b. For ControlWave devices, you need to configure an Archive module to store the required signal values historically. For further help consult the ControlWave Designer or ACCOL documentation.

2. OpenEnterprise must be configured to collect the historical data.
   a. For ROC devices, this can be achieved using the ROC configuration tool. For further help, consult the ROC Configuration Tool Reference Guide (document number D301654x412).
   b. For ControlWave devices you need to set up NW3000 Archiving. For further help, consult the NW3000 Archiving Overview (document number D301506x412) and NW3000 Archive Configuration (document number D301505x412) Reference Guides.

3. DeltaV must be configured to use the embedded PI Historian. For further help see the DeltaV documentation.
3.13.3.3 The Gateway Historical Export Application

The Gateway Historical Export Application instantiates an active query on the `historicalExportRecord` table in OpenEnterprise. Any new records in this table will trigger the application to begin streaming the updates to the PI Server.

If OpenEnterprise loses connection to the remote controllers, then when a connection is reestablished, OpenEnterprise will collect historical data from the remote controllers and insert it into the relevant historical tables. The historical records are transferred to the `historicalExportRecord` table, and the Gateway Historical Export Application will be triggered to begin streaming these updates to the PI Server.

The export process will then either insert this data into PI, update existing data by replacing duplicates, or ignore duplicate data altogether. DeltaV will then be able to access historical data in PI using its suite of analysis tools (trending, etc.).

There will be a delay between timestamp values logged by DeltaV and those logged by OpenEnterprise. Thus, when replacing duplicate records, a method is used to correlate those records which belong to the same logged timestamp. This is done by comparing incoming records with existing records and allowing for a small tolerance in the timestamp value, which by default will be 1 second. This allows any new records to be up to 1 second either side of the currently logged timestamp, to be considered the same logged record. You can change this value on the Historical Backfill General properties page.

The PI server can be configured to work with UTC timestamps. This is done when configuring the scan class in the PI OPC interface. The scan class is used to determine how often PI will collect data, and has an optional flag to set the logged occurrence time to UTC.

Therefore if the PI OPC interface has been configured for DST, the PI Backfill service will adjust timestamps from OpenEnterprise before inserting / updating into PI. In order to utilize this, you must configure the timestamp UTC logging flag within the service.
3.13.4 Alarm and Event Integration

Alarm and event data from the DeltaV RTU Connect is streamed from the Bristol Alarm and Event OPC server to the Plantwide Event Historian running on an application station, where it becomes available to the DeltaV system.

3.13.4.1 Plantwide Event Historian (PEH)

The Plantwide Event Historian is installed on a separate DeltaV application station. It records plant event information from the OpenEnterprise OPC Alarm and Events server, and stores it in a Microsoft SQL Server database.

3.13.4.2 PEH Events Manager

The Events Manager receives the events data from the PEH OPC server and inserts the data into the SQL Server database. Each event stored contains the name of the Alarm and Event OPC server, the time stamp of the event, the type of event, the description of the event, as well as many other standard attributes that are communicated by the Alarm and Event OPC server.

3.13.4.3 PEH Diagnostic Server

The Plantwide Event Historian Diagnostics Server collects the status of the Events Manager, the MSMQ, the PEH OPC Servers and the OPC Alarms & Events servers. You are then able to view and use this data for diagnostic purposes using the PEH Diagnostic Tool.

3.13.4.4 MSMQ

The Plantwide Event Historian uses Microsoft Message Queue (MSMQ) for communicating between the Plantwide Event Historian OPC Server and the SQL Server database.

The MSMQ has a sending end and a receiving end. The sending end of the MSMQ is incorporated into the PEH OPC Server; the receiving end of the MSMQ is incorporated into the PEH Events Manager.

If there is a communications failure between the sending end and the receiving end of the MSMQ, the MSMQ buffers the event data on the sending end and delivers it to the receiving end when the communications are restored, ensuring no data is lost.
3.13.4.5 **PEH OPC Server**

The PEH OPC server should be installed on the DeltaV RTU Connect computer. The PEH OPC server communicates with the OpenEnterprise OPC Alarms & Events server through the standard OPC COM (Component Object Model) interface.

The PEH OPC server then forwards the event data to the PEH Events Manager, which inserts the event data to the PEH SQL Server database.

3.13.4.6 **OpenEnterprise Alarm and Event OPC Server**

The OpenEnterprise OPC Alarm and Event server serves alarm and event data from the OpenEnterprise database to the PEH OPC server, which then passes this data through to the PEH Event Manager. The PEH Event Manager then inserts the data into the PEH database.

The program id of the OpenEnterprise Alarm and Event OPC server is: **BristolBabcock.BristolOPCEventServer**.

3.13.4.7 **OpenEnterprise**

OpenEnterprise is an industrial strength SCADA (Supervisory Control and Data Acquisition) system.

OpenEnterprise collects data from Remote Telemetry Units (RTUs) using direct low level communications programs and serves the data to clients, normally through standard OPC and ODBC application interfaces.

Typical systems include a processing plant (for instance a well head, pipeline or water processing plant) connected to ControlWave or ROC RTUs and communication systems to transmit the data back to the OpenEnterprise server database.

3.13.4.8 **Remote Device Interfaces (RDIs)**

OpenEnterprise communicates with ControlWave and ROC RTUs using a set of device drivers called Remote Device Interfaces (RDIs). Collected data can consist of current values, history and alarm and event data.

3.13.4.8.1 **The ControlWave RDI**

The ControlWave RDI is also known as the NW3000 RDI since the original family of Bristol devices were known by the name Network 3000.

The ControlWave RDI (Remote Device Interface) is installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ControlWave RTUs.

The ControlWave RDI’s configuration program is the NW3000 Setup Tool, which utilizes two other programs:

- The NW3000 Signal Builder inserts, modifies, and deletes signals from the database
- The Template Builder creates polling templates from those signals for efficient data collection.

The ControlWave RDI requires OpenBSI to be installed on the same machine along with the ControlWave control strategy files and network definition.
3.13.4.8.2 The ROC RDI
The ROC RDI (Remote Device Interface) is also installed as part of OpenEnterprise. It is a communications program that enables OpenEnterprise to communicate with and collect data from ROC and FloBoss RTUs.

ROC RDI is has its own configuration tool which enables you to add ROC devices and points to the database and schedule data collection.

3.13.4.9 Polling of RTUs
The frequency of real-time updates through the OPC Mirror will be restricted by the rate at which OpenEnterprise is able to collect the data. In many cases where only a dial-up connection exists, this may be once a day, and / or on demand. At that time, the RTU Gateway will obtain historical signal data from the RTUs and stream it to DeltaV.

4. User Interface
The DeltaV Export Configuration Tool enables you to configure the remote RTU tags that you want to integrate into the DeltaV system.

This section provides you with a detailed description of the DeltaV Export Configuration Tool user interface.
4.1 Menu Bar

There are four menus available on the menu bar.

4.1.1 File Menu

The file menu enables you to import and export configured rule sets. These are saved in XML format. For more information on rule sets, see the Rule Sets Pane topic.

4.1.2 View Menu

4.1.2.1 Show Search
When checked, the user interface displays the search criteria controls. When unchecked, the search criteria controls are removed, and the search list is extended upwards.

4.1.2.2 Show Status
When checked, the user interface displays the status pane. When unchecked, the status pane is removed, and the DeltaV Explorer pane is extended downwards.

4.1.3 Tools Menu
The Tools menu contains only the Properties... item, which opens the Properties dialog.
4.1.4 Help Menu
There are two options under the Help menu.

4.1.4.1 Help
This option opens the Help file for the Emerson Remote Integration Tool (Export Configuration Tool).

4.1.4.2 About
This opens the About box for the Export Configuration Tool.

4.2 Tool Bar
There are two buttons on the tool bar that enable you to import and export rule sets (i.e., search criteria).

4.2.1 Import Rule Set
Selecting this button allows you to import a previously saved rule set. It opens a file selection dialog that enables you to find the saved rule set. It is the same as selecting the File > Import Rule Set menu.

4.2.2 Export Rule Set
Selecting this button allows you to export a rule set that you have configured. It opens a file selection dialog that enables you to find a location where rule set will be saved. It is the same as selecting the File > Export Rule Set menu.

4.3 Search Criteria Controls
This section contains input fields that enable you to create search criteria for signals that you want to integrate into DeltaV. The fields represent attributes belonging to the signal tables within the OpenEnterprise database. A set of search criteria is known as a rule set. A rule set can be used to represent an asset type or RTU type for repeat exports.

Each field can contain text and the wildcard asterisk (*), which finds all signals that contain the text prior to or after the wildcard. A percent character (%) can be used as an alternative to (*) and is treated identically.

For instance "ROC*" in the Device name field will find all signals beginning with "ROC1" such as "ROC10", "ROC21", etc.. If you type "*AIN*" into the Signal name field, the search will find all signals that have the sub string "AIN" within their name such as "ROC1:AIN.1.EU", "ROC12:AIN.3.CALRAW1", "FB107:AIN.3.EU", etc..
The explanation of each field and button available here is given in the headings below the image.

4.3.1 **Device name**
Text typed here will filter the signal search using the “devicename” attribute.

4.3.2 **Signal name**
Text typed here will filter the signal search using the signal name.

4.3.3 **Description**
Text typed here will filter the signal search using the “description” attribute.

4.3.4 **Match case**
If this box is unchecked (default setting), the signal search will not be case sensitive. If it is checked, the search will be case sensitive.

4.3.5 **Instance**
Text typed here will filter the signal search using the “instance” attribute.

4.3.6 **Base**
Text typed here will filter the signal search using the “base” attribute.

4.3.7 **Extension**
Text typed here will filter the signal search using the “extension” attribute.

4.3.8 **Attribute**
Text typed here will filter the signal search using the “attribute” attribute.

4.3.9 **Search for Signals**
Select this button to start a signal search based on the criteria that you provided.

4.3.10 **Add Rule Set**
A rule set is a particular search criteria configuration. If you have created a new search criteria configuration, you can add it to the other rule sets by selecting this button.

The search criteria in a single rule set works on a logical AND basis. Multiple rule sets work on an OR basis.
4.3.11 Using Aliases in Rule Sets
It is possible to use aliases in rule sets to provide finer tuning when searching for tags of interest. See the How to use Aliases in Searches topic for details.

4.3.12 Modify Rule Set
If you have modified an existing rule set in the search criteria, you can update this rule by selecting this button. The corresponding rule set in the rule sets pane will be updated.

4.4 Rule Sets Pane
A rule set is a particular set of search criteria that has been saved. You can save a rule set by clicking the Add Rule Set button on the search criteria controls section of the user interface. A saved rule set is listed in the Rule sets pane, shown in the example below.

4.4.1 Delete Rule Set
Click this button to delete a selected rule set.

4.4.2 Search using Rule Sets
Click this button to begin a signal search using a combination of all rule sets in the rule set pane. Rule sets are strung together by an OR condition, so the query can be potentially widened out.
4.5 Search List Pane
Click the search button immediately above this pane and the list is populated with OpenEnterprise signals that match the search criteria. They are then available for export into DeltaV. This is a two-stage process.

1. The signals must be dragged over into the DeltaV pane.
2. The signals can then be exported by clicking the [Export] button above the DeltaV pane.

4.5.1 Background Colors
The background color of the signals will show their status. The default colors are:

1. Blue: Signals already dragged

This color denotes signals that are currently in the DeltaV pane. They may also have been exported previously. If an export takes place now, they will continue to be in the DeltaV system.
2. **Gray: Signals already exported**

This color denotes signals that were previously exported to DeltaV, but no longer exist in the DeltaV pane. If an export takes place now, these signals will no longer be in the DeltaV system.

3. **Darker Blue with a line around: Signals selected for dragging**

Signals with this color have been selected for dragging across to the DeltaV pane.

See the Selecting Signals section below to view keyboard options that are available when selecting signals.

4.5.2 **Selecting Signals**

Signals can be selected in many ways, from a single signal to multiple signals. There are two ways of selecting multiple signals.

4.5.2.1 **Selecting a Single Signal**

Just left click with the mouse on the signal.

4.5.2.2 **Selecting a Single Block of Signals**

You begin selecting a continuous block of signals by clicking with the left mouse button on the first signal, then holding the [Shift] key. Then click with the left mouse button on the last signal in the block.

4.5.2.3 **Selecting Multiple Blocks of Signals**

First, select the first block of signals as described above, then hold the [Ctrl] key down on your keyboard and select the first signal in the next block. Now stop holding the [Ctrl] key and hold instead the [Shift] key. Then select the last signal in the new block.
4.5.2.4 Selecting All Signals
You can instantly select all of the signals in the signal list by keeping the [Ctrl] key on the keyboard held down as you press the A (or a) key.

See the Dragging Signals section below to see keyboard shortcuts that are available when dragging signals.

4.5.3 Dragging Signals
Once you have selected a single or a single block of signals, you can literally drag them over to the DeltaV pane with the mouse. Hold the left mouse button down as you do this.

However there is a keyboard combination that will do this for you. When you have selected the signals you want, hold the [Ctrl] and D keys down to move them automatically over to the DeltaV pane.

4.5.4 Show New Signals Only
Check this box if you want the search list pane to only show signals that have not been exported over to the DeltaV pane.

This could be helpful if you have already exported a large number of signal tags (e.g., in excess of 3000), since the processing required to display such a large number of tags may cause a noticeable delay in updating the search list.

4.5.5 Hide Dragged Items
Check this box if you want items that have already been dragged over to the DeltaV pane to be hidden from the search list.

If you have deleted an object from the DeltaV pane that has already been dragged and exported, it will now show in the search list as an item that has previously been exported, but not yet dragged.

4.5.6 Signals Found
This label will display the total number of signals found using the search criteria.

4.5.7 Data Service
This label displays the data service that the DeltaV Export Configuration Tool is connected to.

4.5.8 Signal Properties Dialog
Double click any individual signal entry within the search summary panel to view its details in the Signal Properties dialog.

On this dialog there is a “Disable historical export” check box, which enables you to specify whether historical logging of the selected signal should be enabled / disabled.

By default, each signal is enabled for historical logging. This parameter is stored as the “disablehistoricalexport” attribute within the signal table of the OpenEnterprise database.
You can also modify the signal’s description from here.

4.6 DeltaV Pane

This pane provides a view which corresponds to what you would see in DeltaV explorer. It defines a control strategy with plant areas, modules and signals / alarms.

You populate it by selecting signals from the search list and drag / drop these to any relevant node within this view to create your control strategy for the DeltaV Virtual Controller. When a signal is dragged over into the DeltaV explorer view it will reformat its signal name to a prescribed format. This particular format can be configured on the Tag Format property page.

The control strategy will then be exported to an .FHX file, which will be read by the Virtual Controller. If the Status Pane informs you that you need to change some DeltaV tag names, the names will be updated automatically as you change them, whether you do it one by one using the signal locator buttons at the top of the pane or whether you use the Tag Format and Alarm Association pages of the Properties dialog.
4.6.1 Name Change Buttons

When the Export Configuration Tool detects that you have drag / dropped signals that have names that are above the 16 character limit imposed by DeltaV, two things happen:

1. The Name Change buttons become enabled.

![Name Change Buttons](image1)

2. The Status Pane will inform you if any signals require a name change.

![Status Pane](image2)

You can change the names one at a time by clicking on the Name Change buttons, or using the left and right cursor keys on the keyboard to scroll up and down the DeltaV explorer pane. Only tags requiring a name change are selected each time you click a button or a cursor key, as seen in the example below. You can then change the name of the selected signal.

![Examples](image3)

4.6.2 Export Button

When you select the [Export] button at the top of the DeltaV pane, the Export Configuration Tool will create an .FHX file that will be recognized as a control strategy file by DeltaV.
If there are tag names that exceed the 16 character limit, have illegal characters or are duplicated, you will see this warning:

![Warning Message](image)

Just click the [OK] button and make the changes indicated, then try to export again.

### 4.6.2.1 Use the Default .FHX Filename or Change

If there are no signals requiring a change, you will see the **Save As** dialog. You can change both the file name and the destination using this dialog before finally saving.

The default filename will already be in the **File name** field. This is configured on the General page of the Properties dialog.

### 4.6.2.2 Warning Messages

Note that when an import into DeltaV occurs, a couple of warning messages may appear. This is normal operation and is nothing to worry about.

The first message says “WARNING: No SCHEMA block was found at the head of this import file”. This message occurs when .FHX header information is not included in the .FHX export. This is intentional, because it allows us to produce files which are not associated with specific DeltaV versions.

The second message says “Warning: the imported index (1) for Plant Area ‘<PlantArea>’ is different from the existing index (0). The existing index will be used.” This message appears if you added an Area into DeltaV Explorer and then used the Export Configuration Tool to import a new area. The Export Configuration Tool has no knowledge of the area already configured in DeltaV, so the warning message is generated. Again, this is nothing to worry about.

When closing the tool, the following messagebox will appear if signals have been dragged or deleted or name changes made and an export has not taken place.

![Unexported edits](image)

If you do not want to lose your changes, select [No] and click the Export button before closing.
4.6.2.3 *DeltaV Alarm Names*

When an .FHX has been exported and viewed in DeltaV Control Designer, each alarm configured will have its own associated internal alarm name. In order to maintain a unique set of internal alarms, each is given a unique generic name, which is non-configurable.

4.6.3 Adding Areas

When you right click with the mouse on the main Control Strategies node, a context menu appears.

4.6.3.1 Add an Area

Select this option to add a new plant area to the control strategy. The new area will be given the name configured on the Tag Format page of the Properties dialog.

4.6.3.2 Expand all

Expands the currently selected node. The option is grayed out if the node is already expanded.

4.6.3.3 Collapse all

Collapses the currently selected node. The option is greyed out if the node is already collapsed.

4.6.3.4 Export

Exports the current control strategy to an .FHX file.

4.6.4 Adding Modules

When you right click with the mouse on any Plant Area node, a context menu appears.

4.6.4.1 Add a Module

Select this option to add a new module to the control strategy. The new module will be given the name configured on the Tag Format page of the Properties dialog.
4.6.4.2 DeltaV Module Naming Conventions
A list of reserved DeltaV module naming rules is provided below. Failure to observe these rules will cause the .FHX file export to fail. The Export Configuration Tool will test for conformance with all rules listed below except for the DeltaV reserved names.

- Names must be alphanumeric.
- Names cannot exceed 16 characters.
- Names must contain at least one alpha character.
- Names should not match any of the function block names in the system. This includes default function block names, user-defined names and function block template names. Using the same names for modules and function blocks may prevent the system from successfully browsing to parameter names under some circumstances.
- Names can contain $, -, or _.
- Names cannot be any of the following reserved DeltaV names:
  - __$TEST$__
  - BATCH
  - BHIST
  - CHIST
  - COMM
  - CONF
  - CONT
  - DELTAV
  - IO1
  - JOUR
  - NVM
  - OPC
  - OPCMIRROR
  - OPER
  - PHIST
  - PRI
  - PVXIO
  - REDU

4.6.4.3 Expand all
Expands the currently selected node. The option is greyed out if the node is already expanded.

4.6.4.4 Collapse all
Collapses the currently selected node. The option is greyed out if the node is already collapsed.

4.6.4.5 Delete
Deletes the currently selected plant area along with any modules and signals that may already belong to it. A warning will appear before the deletion takes place, with an option to abort.

4.6.4.6 Rename
Renames the currently selected plant area.
4.6.5 Deleting Signals
If you right click with the mouse on any signal in the DeltaV window, a context menu allows you to delete that signal from the list.

4.6.6 Performance Issues
If the tool has been configured to export a large number of signals (between 3 and 5000), there will be a noticeable delay at startup. This is due to the signals being loaded into the DeltaV Explorer view.

4.6.7 Gateway Export Tool Settings
The DeltaV Export Configuration Tool assumes defaults, according to restrictions applied by DeltaV for the maximum number of areas, modules per area, input blocks per module that can be created for export, as well as the maximum number of characters allowed in the tag name. For projects not requiring export of an .FHX file, these restrictions can be modified using the Settings Editor. For further help on this see the Gateway Export Key topic in the Settings Editor documentation.

4.7 Status Pane

The Status Pane will inform you of:

1. The number of signals currently requiring a name change before export. You will need to change the names of these signals before you export to an .FHX file.
2. The number of alarm blocks that require a name change. As with signals, you will have to rename any alarm blocks that need a name change before you can export the configuration.
3. The number of areas that are currently configured for exporting to an .FHX file.
4. The number of modules that are currently configured for exporting to an .FHX file.
5. The number of signals that are currently configured for exporting to an .FHX file. There is currently a 5000 tag limit on exports.
6. The number of alarm blocks that are currently configured for exporting to an .FHX file.
7. The number of OPC Mirror links that are currently configured for exporting to an .FHX file.
4.8 Properties Dialog

The **Properties** dialog has selectable options in the left pane that change the configuration items that are displayed in the right pane.

4.8.1 General Page

The **General** page enables you to configure the Application Station name and also a default .FHX file name and location. It also allows you to change the colors used in the search list for signals that have been exported or dragged into the virtual controller pane already.
4.8.1.1 Application station node name
Enter the name of the DeltaV application station that the RTU Connect is installed on.

4.8.1.2 Default filename
Type a default name for any exported .FHX files that you create.

4.8.1.3 Default output location
Use the small ellipsis button [...] to the right of this field to browse for a suitable location for your .FHX files.

4.8.1.4 Removed from Export Color
This image below shows the default background color that will be given to signals in the search list that were included in the last export, but currently are not in the DeltaV list. You can change this color by clicking on the colored button. A palette dialog will load, enabling you to select a different color.

A signal with the exported color is shown in the example below: This means that this signal was exported last time, but it has subsequently been deleted from the DeltaV pane. If you export now, this signal will not be in the DeltaV export. To include it in any subsequent DeltaV export, you will have to drag it over to the DeltaV pane again.

4.8.1.5 Exported Color
This control shows the default background color that will be given to signals in the search list pane that are currently also in the DeltaV pane. You can change the color by clicking on the colored button. A palette dialog will load, enabling you to select a different color.

A signal with the exported color is shown in the example below:
Note, the exported color can mean that the signal has just been dragged over to the DeltaV pane, but has not yet been exported, or that it is already in the DeltaV pane from the last time an export took place. If it remains in this state, it will also be exported to DeltaV again this time.

If you exported this signal last time you exported to DeltaV and have not subsequently removed it from the DeltaV pane, it will show up as if it had been dragged. The dragged color takes precedence, because it shows clearly what signals will be exported when the [Export] button is next selected.

4.8.2 Tag Format Page

The Tag Format page enables you to determine how signal names from OpenEnterprise will be modified before being exported to the DeltaV virtual controller view pane.

4.8.2.1 Tag buttons

This row of buttons can be used to modify the signal name that is exported to the virtual controller module pane (this is how the signal will appear in DeltaV Explorer). To use them, position the cursor along the Signals / Alarms or Alarm Block input text fields and then click the tag alias button that you want to appear in the string that gets exported.

This enables you to quickly build up a pattern that you want to use for exporting signals and alarms. In the example below, the cursor was placed at the beginning of the Signals / Alarms field, and then the Device button was selected.
4.8.2.1.1 OpenEnterprise Signal Naming Convention

OpenEnterprise signals are created with sections that may or may not be used. The sections are <Device>, <Instance>, <Base>, <Extension>, and <Attribute>. The general rule is that the <Device> name must appear first, followed by a colon, then one or more of the other sections may appear, separated by a dot. Each signal name must be unique. An example would be:

In the example above the following conventions are applied:

- Device name = ROC1 (meaning ROC device number 1)
- Base = AIN (meaning the signal refers to a ROC Analog Input point)
- Extension = 2 (meaning the 2nd Analog Input in the ROC1 device)
- Attribute = EU (meaning this signal represents the EU parameter of the specific Analog Input point)

4.8.2.1.2 DeltaV Signal Names

DeltaV signal names are limited to 16 characters, whereas OpenEnterprise signal names may be much longer. It is a good idea to bear this in mind when configuring ROC or ControlWave RTUs that need to export data to a DeltaV system. Try to make the signal names as short as possible without losing any information.

Also, full stops may not be used in DeltaV signal names, so they may be replaced with an underscore, or removed altogether. Below is an example tag format structure that may be applied using the Tag Format Properties dialog:

If this was used to export signal names, the **ROC1:AIN.2.EU** signal would be exported to DeltaV as **ROC1_AIN2_EU**.

4.8.2.2 Signals / Alarms Input Field

This field is where you can create a tag format which will apply to any OpenEnterprise signals that you want to export to DeltaV. You can use the tag buttons and keyboard to build up the tag format that will be applied to the signals you select for export.
4.8.2.3 **Alarm Block Import**

This field allows you to create a tag format which applies to any alarm block signals that you export to DeltaV. You can create an association between signal names and their alarm conditions using the Alarm Association page.

Many signals in OpenEnterprise may have alarm signals attached to them. With analogue signals this will take the form of a block of alarm limit signals (e.g., HiHi, Hi, Lo, LoLo). For digital signals these will be two change of state alarm conditions (e.g., True, False or On, Off).

4.8.2.4 **Enable Function Block Auto Increment**

When this box is checked, function blocks will be given an automatically generated incremental number after the name, so that they are all unique.

4.8.2.5 **Native Alarm Block**

Check this box if you want to use DeltaV native alarm function blocks. Otherwise, the DeltaV RTU Connect will create simulated alarm function blocks.

4.8.2.6 **Remove Illegal Characters**

When this box is checked, any illegal characters found in signal / alarm names will be automatically removed when they are dragged to the DeltaV pane. In this context, illegal characters are those which do not include alphanumeric characters, $, -, or _.

4.8.2.7 **Area Name Format**

This field is for defining a default name when adding areas to the DeltaV pane. The default name is “SCADA_Area{0}”, where “{0}” denotes an incremental number that is to be added automatically to the name. The incremental number can be moved to any position within the name by moving the “{0}”.

4.8.2.8 **Module Name Format**

This field is for defining a default name when adding modules to the DeltaV pane. The default name is “SCADA_Module{0}”, where “{0}” denotes an incremental number is to be added automatically to the name. The incremental number can be moved to any position within the name by moving the “{0}”.
4.8.2.9 **OK Button**

When this button is selected on the Tag Format page, the following message will prompt you to decide whether to change all names that are currently in the DeltaV pane to the new format.

If you select [Yes] the changes will be automatically applied to all signals that have been dragged into the DeltaV Explorer pane.

If you select the [No] button no names will be changed. You can change signal names one at a time later, using the name change buttons which appear at the top of the DeltaV pane when inadmissible names are present. See the Name Change Buttons heading on the DeltaV Pane topic for more information.

4.8.2.10 **Cancel Button**

If this button is selected, any changes configured on the page will not be applied.

4.8.3 **Alarm Association Page**

This page enables you to specify rules that will map alarm limit signals to their source signals. Signals having the defined attribute names will be matched with any associated alarm limits which have been mapped here.

4.8.3.1 **Text Entry Field**

Type the attribute value for the signals or alarm limit signals that you want to create an association for here.
4.8.3.2 Alarm Association Controls

Once you have entered text into the Text Entry Field, click on the appropriate button (Attribute, High High, High, Low or Low low or Deadband) to enter it into the correct field. In the example setup below there are two attributes defined and 3 example Alarm Association Sets configured. We will now explain how this setup will work.

Note: The background colors have been added to the example above to aid in referencing the alarm associations, and are not a part of the actual user interface.

4.8.3.2.1 Signal Naming Conventions

The default signal naming convention adopted by OpenEnterprise splits signal names into four parts as follows:

\(<DeviceName>:\<Base>\:<Extension>\:<Attribute>\)

4.8.3.2.2 Attribute 1 - EU

Source signals having an Attribute value of EU will be associated with alarm limit signals that have the same Device, Base and Extension. Each limit signal will defined by the Alarm Associations provided.

In this example, the source signal with the name ROC1:AIN.2.EU would be associated with alarm limit signals defined in Alarm Association Set 1 or Alarm Association Set 2.

4.8.3.2.2.1 Alarm Association Set 1

This alarm association set will associate the following alarm limit signals with the source signal ROC1:AIN.2.EU:

- ROC1:AIN.2.HIHI
- ROC1:AIN.2.HI
- ROC1:AIN.2.LO
- ROC1:AIN.2.LOLO

It will also associate the source signal with any alarm deadband signal having the name ROC1:AIN.2.ALBND.

When the associated signals are exported to an .FHX file, they will be exported as a Native or Simulated Alarm Function Block.
4.8.3.2.2 Alarm Association Set 2

This alarm association set will associate the following alarm limit signals with the source signal ROC1:AIN.2.EU:

- ROC1:AIN.2.HIHIALM
- ROC1:AIN.2.HIALM
- ROC1:AIN.2.LOALM
- ROC1:AIN.2.LOLOALM

It will also associate the source signal with any alarm deadband signal having the name ROC1.AIN.2.ALDBND.

When the associated signals are exported to an .FHX file, they will be exported as a Native or Simulated Alarm Function Block.

4.8.3.2.3 Attribute 2 - OUTPT

The second Attribute value for the source signal is OUTPT. In this particular example, the Attribute for associated alarm signals extends the source Attribute rather than replacing it altogether.

So, in our example the source signal with the name CW1:ANIN.STRE.OUTPT is associated with alarm limit signals defined in Alarm Association Set 3.

4.8.3.2.3.1 Alarm Association Set 3

This alarm association set will associate the following alarm limit signals with the source signal CW1:ANIN.STRE.OUTPT:

- CW1:ANIN.STRE.OUTPT_HIHI
- CW1:ANIN.STRE.OUTPT_HI
- CW1:ANIN.STRE.OUTPT_LO
- CW1:ANIN.STRE.OUTPT_LOLO

It will also associate the source signal with an alarm deadband signal having the name CW1.ANIN.STRE.ALDBND.

When the associated signals are exported to an .FHX file, they will be exported as a Native or Simulated Alarm Function Block.
4.8.3.2.4 Native Alarm Function Blocks
This is an example of a Native DeltaV Alarm Function Block. As you can see, the five signals that matched the Alarm Associations are set as inputs.

4.8.3.2.5 Simulated Alarm Function Blocks
This is an example of the Simulated Alarm Function Block. It achieves the same as the Native Alarm Function Block with no licensing requirements.
4.8.3.3 Limit Alarm Priority Selectors
Under every alarm limit association list there is a default priority selector. Click on the selector for the limit and select a default priority for that limit from the options available.

4.8.3.4 Digital Priority Selector
At the bottom of the Alarm Association page is a selector that will set a default priority for all digital alarms. Select a priority from the options available.

4.8.4 OPC Mirror Page
This page enables you to configure a default filename and location for the OPC Mirror database, and the name.

4.8.4.1 OPC Mirror Database Location
This is where the OPC Mirror is installed by default. The location can be changed if necessary by using the ellipsis button [...] to browse the new location.

4.8.4.2 Backup Database
When checked (default), the OPC Mirror database is backed up before making changes. The backup database file will be renamed to have "_backup" appended to it, and it will be saved to the same location as the current OPC Mirror database.

4.8.4.3 Pipe Name
The default OPC Mirror pipe name used by the DeltaV RTU Connect. An OPC Mirror pipe is a configuration set that enables the OPC Mirror to pass data between two OPC servers (in this case, the OpenEnterprise OPC server and the DeltaV OPC server). This includes mapping to the signals that are currently in the DeltaV pane.

Every time an .FHX file is exported this OPC Mirror pipe is overwritten.
4.8.5 Historical Backfill
There are two pages for configuring the .DeltaV RTU Connect historical backfill service. They are:

1. The Historical Backfill General Page
2. The Historical Backfill PI Server Page

4.8.5.1 Historical Backfill General Page
This page enables you to configure how the Export Configuration Tool handles history updates to the PI history database residing on the DeltaV network.

- **4.8.5.1.1 Max Number of Records per Update**
  This is the maximum number of history record updates (the default value is 100) which will trigger an update of the PI database. If the maximum number of history updates is not reached before the set elapsed time interval, a PI update will be initiated anyway.

- **4.8.5.1.2 Elapsed Time Before Update is Triggered**
  The time between successive PI database updates (the default value is 60 seconds). If the maximum number of record updates in the OpenEnterprise database is reached before this interval has expired, a PI update will be initiated anyway.
4.8.5.1.3 Record Insertion Type

Defines how the Gateway history update service deals with Historical Backfill updates as it receives them. The options are:

- **Insert** - The default option. All updates will automatically be inserted into the PI database. This will be the best option if OpenEnterprise can only poll the remote controllers at infrequent intervals. In this scenario, there will not be enough data from the pass through operation to warrant replacing or discarding records. All updates received from the Gateway Historical Export application will be inserted into the PI historical database. To learn more about the difference between integrating historical data via data pass through or historical backfill see the Data Pass Through and Historical Backfill Integration topics.

- **Insert or Replace** - If this option is selected, when the Gateway Historical Export application receives updates, any records already in the PI database that have the same tag name and a timestamp that is within the timestamp tolerance value set in the Export Configuration Tool will be deemed to be the same record. The Gateway Historical Export application will replace these records with the ones that have been collected via historical backfill. If no there is no timestamp match found a new record will be inserted into the PI database. Note that this option introduces extra processing, so throughput may be perceptibly slower, depending on the number of tags involved.

- **Replace or Discard** - Any updates in the Gateway Historical Export application queue that have the same tag name and a timestamp within the timestamp tolerance value will be discarded.

4.8.5.1.4 Timestamp Tolerance for Record Update

An interval in seconds that only affects what the RTU Connect history update service will do when the insertion type is set to Replace or Discard. Consequently, the field is only enabled when the Replace or Discard insertion type is selected.

If the insertion type is Replace, any updates that have the same tag name and a timestamp that is within the timestamp tolerance value will replace those already in the PI database.

If the insertion type is Discard, updates in the queue that have the same tag name and a timestamp within the timestamp tolerance value will be discarded.

4.8.5.1.5 Log Timestamps in UTC

If checked, timestamps will be sent to the PI database in UTC time, if unchecked timestamps will be sent in local time.
4.8.5.1.6 Allow for Integer Values to be Stored as Float
If checked the history service sends integer values to the PI database as float types.

4.8.5.1.7 Minimum Query Interval
Used to make the active query more efficient. When set to a value above zero, the underlying active query engine will effectively poll batches of data at the interval, rather than allow for a continuous asynchronous set of updates (which is the case if this value is set to zero). The default value is zero.

4.8.5.2 Historical Backfill PI Server Page
This page enables you to configure how the Export Configuration Tool handles history updates to the PI history database residing on the DeltaV network.

4.8.5.2.1 Name of PI Server
The name of the PI server should be entered here. The PI server name is configured when installing the PI SDK. If this field is left blank, the default PI Server name on the network will be used.

4.8.5.2.2 Create New PI Points if Missing
If checked, when updating, the RTU Connect history service will create new PI points if they are not found in the PI database.
4.8.5.2.3 Allow Compression for Newly Created Points
When checked the RTU Connect will allow compression for newly created history points.

4.8.5.2.4 Default Logon
When the Default logon box is checked, the RTU Connect history service will log into the PI database with the default values. The default user values are configured when installing the PI SDK. When unchecked the Username, Password and confirm boxes become enabled so that you can enter different security details.
5. Index

A
Alarm and Event Integration ............................................. 22
Alarm Association .......................................................... 6, 44
Aliases .................................................................................. 6
Application Station .................................................................. 10
C
Configure ............................................................................. 5, 8
  PI Server ........................................................................... 9
  RTU Gateway ................................................................... 5
Create .................................................................................... 6, 8
  DeltaV Control Strategy .................................................... 8
D
Data Pass Through ............................................................ 16
Default_Logon ....................................................................... 51
DeltaV Control Strategy ....................................................... 8
  Creating ........................................................................... 8
DeltaV Controller ................................................................. 10
DeltaV Explorer Pane .......................................................... 34
DeltaV Export Configuration Tool Overview ....................... 5
DeltaV_Plant ........................................................................ 8
Device_name ......................................................................... 28
Dragged_Color ..................................................................... 40
E
Emerson RTU Gateway .......................................................... 13
Enable_Function_Block_Auto_Increment .......................... 42
Export_rule_set ....................................................................... 27
G
Gateway Config Tool ........................................................... 5
  Opening ............................................................................. 5
Gateway Configuration Tool Interface ............................... 26
Gateway Configuration Tool Introduction ......................... 5
Gateway Historical Export Application ............................... 23
General Properties ............................................................... 40
H
Historical Backfill ............................................................... 20, 49, 50
Historical Backfill General .................................................. 48
Historical Backfill Integration .............................................. 20
Historical Backfill PI Server .................................................. 50
Historical Integration ............................................................. 16

I
Initial Configuration ............................................................. 5

K
Knowledge Base .................................................................. 8

L
Limit_Alarm_PrioritySelectors ........................................... 44

M
Modify Default Control Strategy Areas ............................. 8
Modify Signal Names ........................................................... 8
Modifying Rule Sets ............................................................. 6
Module Names ....................................................................... 8

O
OPC Mirror .......................................................................... 47
OpenEnterprise .................................................................... 12, 23
Opening the Gateway Configuration Tool ......................... 5
Operator Workstation ........................................................... 10

P
PI Server .............................................................................. 9
PI_Client ............................................................................... 19
PI_Historian .......................................................................... 16
Pipe_Name .............................................................................. 47
Properties Dialog ................................................................. 40
ProPlus Workstation ............................................................ 10

R
Real time integration ............................................................ 14
Remote Controllers ............................................................... 11
RTU Gateway ......................................................................... 5
Rule Sets ................................................................................ 6, 29
Rule Sets Pane ....................................................................... 29

S
Search List Pane ................................................................. 30
Searches ................................................................................ 6
Selecting Signals to Import ............................................... 8
Show_Search .......................................................................... 26
Signal Criteria Controls .......................................................... 28
Signal_Properties_Dialog ..................................................... 30
Signals ................................................................................... 29
Status Pane ............................................................................ 39
OpenEnterprise DeltaV Export Configuration Tool

D301682X412

Reference Guide
March 2012

T
Tag Format ......................................................... 42

The_DeltaV_OPC_Server ..................................... 13

U
Use Aliases ......................................................... 6
User Interface ..................................................... 26

V
Virtual Controller .............................................. 11

W
Warning_Messages ............................................. 34

Global Headquarters
Emerson Process Management
Remote Automation Solutions
6005 Rogerdale Road
Houston, TX, USA 77072
T +1 281 879 2699
F +1 281 988 4445


Europe
Emerson Process Management
Remote Automation Solutions
Emerson House
Kirkhill Drive, Kirkhill Industrial Estate
Aberdeen, UK AB21 OEU
T +44 1224 215700
F +44 1224 215799

North America and Latin America
Emerson Process Management
Remote Automation Solutions
6005 Rogerdale Road
Houston, TX, USA 77072
T +1 281 879 2699
F +1 281 988 4445

Middle East and Africa
Emerson Process Management
Remote Automation Solutions
Emerson FZE
PO Box 17033
Jebel Ali Free Zone - South 2
Dubai, UAE
T +971 4 8118100
F +1 281 988 4445

Asia Pacific
Emerson Process Management
Remote Automation Solutions
1 Pandan Crescent
Singapore 128461
T +65 6777 8211
F +65 6777 0947

© 2012 Remote Automation Solutions, a business unit of Emerson Process Management. All rights reserved.

© 2012 Remote Automation Solutions, a business unit of Emerson Electric Co., doing business as Remote Automation Solutions, a business unit of Emerson Process Management. FloBoss, ROCLINK, Bristol, Bristol Babcock, ControlWave, TeleFlow, Helicoid, OSIsoft, OpenEnterprise, and METCO are trademarks of Remote Automation Solutions. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. Remote Automation Solutions reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by Remote Automation Solutions’ terms and conditions which are available upon request. Remote Automation Solutions does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any Remote Automation